Preface

The V5 CATIA - Sheet Metal Design is a new generation product offering an intuitive and flexible user interface. It provides an associative feature-based modeling making it possible to design sheet metal parts in concurrent engineering between the unfolded or folded part representation.

As a scalable product, CATIA Version 5 Sheet Metal Design can be used in cooperation with other current or future companion products in the next CATIA generation such as CATIA Version 5 Assembly Design and CATIA Version 5 Generative Drafting. The widest application portfolio in the industry is also accessible through interoperability with CATIA Solutions Version 4 to enable support of the full product development process from initial concept to product in operation.
Highlights

V5R3 CATIA - Sheet Metal Design offers the following main functions:
- Associative and dedicated Sheet Metal feature based modeling
- Concurrent engineering between the unfolded or folded part representation
- Access to company defined standards tables
- Dedicated drawing capability including unfolded view and specific settings.

All sheetmetal specifications can be re-used by the CATIA - Knowledge Advisor to capture corporate knowledge and increase the quality of designs.
Natively integrated, CATIA - Sheet Metal Design offers the same ease of use and user interface consistency as all CATIA V5 applications.
Using This Product

This guide is intended for the user who needs to become quickly familiar with the CATIA - Sheet Metal Design Version 5 product. The user should be familiar with basic CATIA Version 5 concepts such as document windows, standard and view toolbars.

To get the most out of this guide, we suggest you start reading and performing the step-by-step tutorial "Getting Started".

The next sections deal with the handling of more detailed capabilities of the product.
Where to Find More Information

Prior to reading this book, we recommend that you read the *CATIA - Infrastructure User's Guide*.

## What's New?

<table>
<thead>
<tr>
<th>Enhanced</th>
<th>Defining the Sheet Metal Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creating Swept Walls</td>
</tr>
<tr>
<td>New</td>
<td>Creating Various Stamps</td>
</tr>
<tr>
<td>Enhanced</td>
<td>Recognize/Extrude</td>
</tr>
<tr>
<td>New</td>
<td>Bend Allowance from External Files</td>
</tr>
</tbody>
</table>
Getting Started

Before getting into the detailed instructions for using Version 5 CATIA - Sheet Metal Design, the following tutorial provides a step-by-step scenario demonstrating how to use key functionalities.

The main tasks proposed in this section are:

- Entering the Workbench
- Defining the Parameters
- Creating the First Wall
- Creating the Side Walls
- Creating a Cutout
- Creating Automatic Bends
- Unfolding the Part
- Extracting Drawings

All together, these tasks should take about 15 minutes to complete.
Accessing the Sheet Metal Workbench

The Sheet Metal Design functions are available when you are in the Part environment. Several functions are integrated from Part Design workbench.

This task shows how to enter the workbench.

Choose the Sheet Metal Design item from the Start menu.

The Sheet Metal toolbar is displayed and ready to use.

You may add the Sheet Metal Design workbench to your Favorites, using the Tools -> Customize item. For more information, refer to CATIA V5 - Infrastructure User's Guide.
Up

Creating the First Wall

Creating Automatic Bends

Entering the Workbench

Creating the Side Walls

Unfolding the Part

Defining the Parameters

Creating a Cutout

Extracting Drawings
Defining the Sheet Metal Parameters

This task shows you how to configure the sheet metal parameters.

1. Click the Parameters icon. The Sheet Metal Parameters dialog box is displayed.

2. Enter 1mm in the Thickness field.
3. Enter 5mm in the Bend Radius field.
4. Select the Bend Extremities tab.

5. Select Tangent in the Bend Extremities combo list.
An alternative is to select the bend type in the graphical combo list.

6. Click OK to validate the parameters and close the dialog box. The Sheet Metal Parameters feature is added in the specification tree.
Creating the First Wall

This task shows how to create the first wall of the Sheet Metal Part.

1. Click the Sketcher icon then select the xy plane.

2. Select the Profile icon.

3. Sketch the contour as shown below:

4. Click the Exit Sketcher icon to return to the 3D world.

5. Click the Wall icon. The Wall Definition dialog box opens.

6. Click OK. The Wall.1 feature is added in the specification tree.
The first wall of the Sheet Metal Part is known as the Reference wall.
Creating the Side Walls

This task shows you how to add other walls to the Sheet Metal part.

1. Select the Wall on Edge icon.
2. Select the left edge. The Wall Definition dialog box opens.
3. Enter 50mm in the Length field. The application previews the wall.
4. Reverse the Sketch Profile.
5. Click OK. The wall is created.

By default, the Material Side is set to the outside and the Sketch Profile to the top.
6. Select the Wall on Edge icon again.
7. Select the right edge. The Wall Definition dialog box opens with the parameters previously selected.

8. Press OK to validate.
9. Select the Wall on Edge icon again.
10. Select the front edge. The Wall Definition dialog box opens with the parameters previously selected.

11. Enter 30 mm in the Length field.
12. Press OK to validate.
13. Relimit the last wall:
   - Select Sketch.4
   - Place the cursor and right-click on the top edge: the contextual menu is displayed.
   - Select Mark.1 object -> Isolate
   - Click the top edge left extremity and drag it 10 mm to the right
   - Click the top edge right extremity and drag it 10 mm to the left

14. Click the Exit Sketcher icon to return to the 3D world.
Eventually, the final part looks like this:
Creating a Cutout

In this task, you will learn how to:

- open a sketch on an existing face
- define a contour in order to create a cutout.

1. Select the wall on the right (Wall.3) to define the working plane.

2. Click the Sketcher icon.

3. Click the Oblong Profile icon to create the contour.
   To access to the oblong profile, click the black triangle on the Rectangle icon. It displays a secondary toolbar.

4. Click to create the first point and drag the cursor.

5. Click to create the second point. The first semi-axis of the profile is created.

6. Drag the cursor and click to create the third point. The second semi-axis is created and CATIA displays the oblong profile.

7. Click the Exit Sketcher icon to return to the 3D world.
8. Select the Cutout icon.

The Pocket Definition dialog box is displayed and CATIA previews a cutout with default parameters.

9. Set the Type to Up to last option to define the limit of your cutout. This means that the application will limit the cutout onto the last possible face, that is the opposite wall.

10. Click OK. This is your cutout:
Creating the Bends Automatically

This task shows how to create the bends automatically.

Click the Automatic Bends icon. The bends are created.

CATIA displays the bends creation in the specification tree: Automatic Bends.

The Sheet Metal part looks like this:
Unfolding the Sheet Metal Part

This task shows how to unfold the part.

1. Click the Unfold icon. The part is unfolded according to the reference wall plane, as shown below.

2. Click this icon again to refold the part for the next task.
Extracting Drawings from the Sheet Metal Part

This task shows how to create the Sheet Metal Part views in the Drafting workbench.

The Sheet Metal part is displayed.

1. Click 📋 or select File -> New...
2. Select the Drawing type and click OK.

The Drafting workbench is launched.
The New Drawing dialog box opens.

3. Keep the default parameters and click OK.

For more information about this workbench, refer to CATIA - Generative Drafting User's Guide.

4. The drawing sheet appears.
5. Tile the windows horizontally.

6. Select the Unfolded View icon 🎨 in the Drafting toolbar.

This icon is added to the Drafting toolbar providing the Sheet Metal workbench is present.

7. Choose the xy plane in the Sheet Metal specification tree.
The unfolded view is displayed with the bends axes.

Eventually, the Drafting sheet looks like this:
The Basic Tasks section explains how to create and modify various kinds of features. The table below lists the information you will find.
Managing the Default Parameters

This section explains and illustrates how to use or modify various kinds of features. The table below lists the information you will find.

Using Sheet Metal Design assumes that you are in a CATPart document.

<table>
<thead>
<tr>
<th>Editing the Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bend Extremities</td>
</tr>
<tr>
<td>Bend Allowance</td>
</tr>
</tbody>
</table>

- Designing in Context
- Creating Swept Walls
- Stamping
- Patterning
- Interoperability
This section explains how to change the different sheet metal parameters.

1. Click the Parameters icon. The Sheet Metal Parameters dialog box is displayed.

2. Change the Thickness if need be.

3. Change the Bend Radius if need be.

Convention dictates that the inner angle between the two walls is used to define the bend. It can vary from 0° to 180° exclusive. This angle is constant and the bend axis is rectilinear.

4. Press the Sheet Standards Files... button to access to the company defined standards, if need be. For more information, refer to the Customizing section.

5. Click OK to validate the Sheet Metal Parameters.
Modifying the Bend Extremities

This section explains how to change the bend extremities.

Click the Parameters icon. The Sheet Metal Parameters dialog box is displayed.

The second tab concerns the bend extremities. A combo box displays the six possible axial relimitations for the straight bend:

- **Minimum with no relief**: the bend corresponds to the common area of the supporting walls along the bend axis.
- **Square relief**: a square relief is added to the bend extremity. The L1 and L2 parameters can be modified if need be.
- **Round relief**: a round relief is added to the bend extremity. The L1 and L2 parameters can be modified if need be.
- **Linear**: the unfolded bend is split by two planes going through the corresponding limit points (obtained by projection of the bend axis onto the edges of the supporting walls).
- **Tangent**: the edges of the bend are tangent to the edges of the supporting walls.
- **Maximum**: the bend is calculated between the furthest opposite edges of the supporting walls.

These options can also be accessed through the pop-up button:
Up

Editing the Parameters

Bend Extremities

Bend Allowance
Defining the Bend Allowance

This section explains the calculations related to folding/unfolding operations.

When a bend is unfolded, the sheet metal deformation is represented by the bend allowance $V$ defined by the formula:

$$L = A + B + V$$

where:

- $L$ is the total unfolded length
- $A$ and $B$ the dimensioning lengths as defined on the figures below:
Another way to compute the sheet metal deformation is the neutral fiber definition (K Factor):

\[ W = \alpha \times (R + k \times T) \]

where:
- \( W \) is the flat bend width
- \( R \) the inner bend radius
- \( T \) the sheet metal thickness
- \( \alpha \) the inner bend angle in radians.

If \( \beta \) is the opening bend angle in degrees:

\[ \alpha = \pi \times (180 - \beta) / 180 \]

Physically, the neutral fiber represents the limit between the material compressed area inside the bend and the extended area outside the bend. Ideally, it is represented by an arc located inside the thickness and centered on the bend axis. Therefore the K Factor always has a value between 0 and 0.5.

When you define the sheet metal parameters, a literal feature defines the default K Factor, according to the DIN standard:

\[ K = (0.65 + \log(R / T) / 2) / 2 \]

This formula can be deactivated or modified using Knowledge Advisor workbench.

When a bend is created, the bend K Factor and the bend allowance literals are created.

Two cases may then occur:

If the Sheet Metal K Factor has an activated formula and uses the default bend radius as input parameter, the same formula is activated on the bend K Factor with the bend radius as input.

Else the bend K Factor is a formula equal to the Sheet Metal K Factor.
The bend allowance literal is equal to a formula representing the use of the bend K Factor. This formula is fairly complex and it is strongly recommended not to delete it.

\[ V = \alpha \cdot (R + k \cdot T) - 2 \cdot (R + T) \cdot \tan \left( \min \left( \frac{\pi}{2}, \alpha \right) / 2 \right) \]

Though it is possible to deactivate the formula to enter a fixed value. Finally, the bend flat width is computed from the bend allowance value.
Creating a Sheet Metal Part from an Existing Solid

This section explains and illustrates how to create and use various kinds of features. The table below lists the information you will find.
Using Sheet Metal Design assumes that you are in a CATPart document.
Recognizing Thin Part Shapes

This task illustrates how to create a Sheet Metal part using an existing solide.

Open the Scenario1.CATPart document from the \online\samples\sheetmetal directory.
The document contains a solide created in the Part Design workbench and it looks like this:

1. Click the Walls Recognition icon.
2. Indicate a face to be the reference wall.

    The walls are generated from the Part Design geometry.

    The Walls Recognition.1 feature is added in the tree view.

At the same time, the Sheet Metal parameters are created, deduced from the Part geometry.

3. Select the icon to edit the Parameters:

    - the Thickness is equal to 1 mm
    - the Bend radius is twice the thickness value

    - the Bend Extremities field is set to Square relief.

The solid is now a Sheet Metal part. All the features are displayed in the specification tree. You can modify the parameters and add new features from the Sheet Metal workbench to complete the design.
Generating Bends from Walls

This task explains two ways to generate the bends in the Sheet Metal part.

The Scenario1.CATPart document is still open from the previous task. If not, open the Scenario1_2.CATPart document from the \online\samples\sheetmetal directory.

1. Select the Bend icon  
   The Bend Definition dialog box opens.

   ![Bend Definition Dialog Box]

   Note that the Radius field is in gray because it is driven by a formula: at that time, you cannot modify the value.

2. Select Wall.1 and Wall.2 in the specification tree.
   The Bend Definition dialog box is updated.

3. Right-click the Radius field: the contextual menu appears.

4. Deactivate the formula: you can now change the value.

5. Enter 4mm for the Radius and click OK.
The Bend is created.

6. Select now the Automatic Bends icon.

The bends are created and the part looks like this:

It is also possible to create first all the bends, using Automatic Bends, then modify the parameters for one or more bends.
1. Select the Automatic Bends icon. The bends are created.

2. Select the bend of interest: Bend.3. The Bend Definition dialog box opens.

3. Right-click the Radius field: the contextual menu appears.

4. Deactivate the formula: you can now change the value.

5. Enter 4mm for the Radius and click OK. Bend.3 is modified.
Adding a Sheet Metal Feature

This task shows you how to complete the design by adding an oblong wall-cut across the bend area on the unfolded view.

The Scenario1.CATPart document is still open from the previous task. If not, open the Scenario1_3.CATPart document from the \online\samples\sheetmetal directory.

1. Unfold the part using this icon.

2. Select the Sketcher icon and choose the xy plane.

3. Select the Oblong icon.

4. Sketch the following profile and quit the Sketcher using the Exit icon.

5. Select the Cutout icon. The Pocket Definition dialog box opens.

6. Enter 1mm in the Length field and click OK.

7. Fold the part again using this icon. Eventually, the part looks like this:
Designing in Context

This section explains and illustrates how to create and use various kinds of features.
The table below lists the information you will find.
Designing...

This task explains how to create a Sheet Metal part in an Assembly context.

Open the Scenario2.CATProduct document from the \online\samples\sheetmetal directory.

You are in Assembly Design workbench.

The document contains two parts.

1. Right-click Product1 in the file tree and select New Part...
   A dialog box is displayed:
   
   ![Part Number Dialog Box]
   
   2. Enter Part3 in the New part Number field and click OK.
      A New Part dialog box proposes two locations to define the origin point.
      For more information, refer to Inserting a New Part.
   
   3. Click No to locate the part origin according to the Product1 origin point.

   Make sure you are in Design Mode:
   - Select Product1
   - Choose Edit -> Design Mode
4. Switch to Sheet Metal Design workbench.

5. Activate Part3.

6. Select the Parameters icon to create the Sheet Metal characteristics for the part:
   - 1mm for the Thickness,
   - 3mm for the Bend radius,
   - Linear for the Bend extremities,

and click OK.

7. Click the Sketcher icon and select the zx plane.

8. Select the Profile icon.

9. Sketch the contour and set the constraints as shown below:
   - 5mm between the Sheet Metal vertical walls and each pad
   - 0mm between the Sheet Metal horizontal walls and each pad top
   - 0mm between the last point of the Sheet Metal sketch and the right pad side.

10. Click the Exit icon to return to the 3D world.

11. Select the Extrusion icon.
12. Select the Sheet Metal profile. The Extrusion Definition dialog box appears.

13. Enter 50mm for Length1 then click OK.
The Material Side should be set to the outside.

14. Select the Automatic Bends icon. The bends are created.

The new features are shown in the specification tree:
- Extrusion.1 with five walls
- Automatic Bends.1 with four bends.

Eventually, the Sheet Metal part looks like this:
In this task, you are going to modify the height and the sketch of Pad.1.

The Scenario2.CATProduct document is open from the previous task. If not, open the Scenario2_2.CATProduct document from the \online\samples\sheetmetal directory.

1. Double-click Part1\Pad.1 in the specification tree.

The dialog box is displayed.

2. Enter 40mm for the Length and click OK. The pad is updated.

3. Select the Product and Update the Sheet Metal part.

4. Select Part1\Pad.1\Sketch.1.

5. Modify the sketch:

6. Click the Exit icon to return to the 3D world.
The constraints are respected.

After the Product update, the document looks like this:
Creating Swept Walls

This section explains and illustrates how to create and use various kinds of features. The table below lists the information you will find.

<table>
<thead>
<tr>
<th>Flange</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hem</td>
</tr>
<tr>
<td>Tear Drop</td>
</tr>
<tr>
<td>Swept Flange</td>
</tr>
</tbody>
</table>

- Designing in Context
- Managing the Default Parameters
- Creating Swept Walls
- Patterning
- From an Existing Solid
- Stamping
- Interoperability
Creating a Flange

This task explains how to generate a flange from a spine and a profile.

Open the SweptWall01.CATPart document from the \online\samples\sheetmetal directory.

1. Select the Flange icon

The Flange Definition dialog box opens.

2. Select the edge as shown in red.
3. Enter 2 mm in the Radius field, 10 mm in the Length field and 120° for the Angle.

4. Click OK to create the flange.

The feature is added to the specification tree.
Creating a Hem

This task explains how to generate a hem from a spine and a profile.

The SweptWall01.CATPart document is still open from the previous task. If not, open the SweptWall02.CATPart document from the \online\samples\sheetmetal directory.

1. Select the Hem icon

The Hem Definition dialog box opens.

2. Select the edges as shown in red.

3. Enter 2 mm in the Radius field, and 3 mm in the Length field.

4. Click OK to create the hem.
The feature is added to the specification tree.
Creating a Tear Drop

This task explains how to generate a tear drop from a spine and a profile.

The SweptWall01.CATPart document is still open from the previous task. If not, open the SweptWall03.CATPart document from the \online\samples\sheetmetal directory.

1. Select the Tear Drop icon.

The Tear Drop Definition dialog box opens.

2. Select the edge as shown in red.

3. Enter 3 mm in the Radius field, and 8 mm in the Length field.

4. Click OK to create the tear drop.
The feature is added to the specification tree.
Creating a Swept Flange

This task explains how to generate a swept flange from a spine and a user-defined profile.

The SweptWall01.CATPart document is still open from the previous task. If not, open the SweptWall04.CATPart document from the \online\samples\sheetmetal directory.

1. Using the Sketcher, define a profile as shown below:

Then quit the Sketcher, using the Exit icon.

2. Select the Swept Flange icon.

The User Defined Flange Definition dialog box opens.

3. Select the edge and the profile, as shown in red.

The dialog box looks like this:

4. Click OK to create the swept flange.
The feature is added in the specification tree.
Stamping

This section explains and illustrates how to create and use various kinds of stamps. The table below lists the information you will find.

<table>
<thead>
<tr>
<th>Point Stamp</th>
<th>Extruded Hole</th>
<th>Curve Stamp</th>
<th>Surface Stamp</th>
<th>Bridge</th>
<th>Louver</th>
<th>Stiffness Rib</th>
</tr>
</thead>
</table>

Up  | Managing the Default Parameters | From an Existing Solid |
Designing in Context | Creating Swept Walls | Stamping |
Patterning | Interoperability |
Creating a Point Stamp

This task shows you how to create a point stamp by specifying the punch geometrical parameters.

1. Click the Point Stamp icon.
2. Select a point on the top face.
   The Point Stamp Definition dialog box opens, providing default values.
3. Change the value in the different fields, if need be:
   - Height H,
   - Radius R1,
   - Radius R2,
   - Angle A,
   - Diameter D.
4. Click OK to validate.

The specification tree indicates the point stamp has been created.
This task shows you how to create an extruded hole by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task. If not, open the Stamping2.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Extruded Hole icon.
2. Select a point on the top face where you want to place the hole.

The Extruded Hole Definition dialog box opens, providing default values.

3. Change the value in the different fields, if need be:
   - Height H,
   - Radius R,
   - Angle A,
   - Diameter D.

4. Click OK to validate.

The specification tree indicates that the extruded hole has been created.
This task shows you how to create a curve stamp by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task. If not, open the Stamping3.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Curve Stamp icon.

2. Select Sketch.4, the curve previously defined. The Curve Stamp Definition dialog box opens, providing default values.

3. Change the value in the different fields, if need be:
   - Height H
   - Radius R1
   - Radius R2
   - Angle A
   - Length L

4. Click OK to validate.
The specification tree indicates that the curve stamp has been created.
This task shows you how to create a surface stamp by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task. If not, open the Stamping4.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Surface Stamp icon.
2. Select Sketch.5, the profile previously defined. The Surface Stamp Definition dialog box opens, providing default values.

3. Change the value in the different fields, if need be:
   - Height H,
   - Radius R1,
   - Radius R2,
   - Angle A.

4. Click OK to validate.

The specification tree indicates that the surface stamp has been created.
This task shows you how to create a bridge by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task. If not, open the Stamping5.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Bridge icon.
   The Bridge Definition dialog box opens, providing default values.

2. Change the value in the different fields, if need be:
   - Height H,
   - Radius R1,
   - Radius R2,
   - Angle A,
   - Length L1,
   - Length L2.

3. Select a point on the top face where you want to place the bridge.

4. Select an edge to give the direction of the bridge.

5. Click OK to validate.
The specification tree indicates that the bridge has been created.
Creating a Louver

This task shows you how to create a louver by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task.
If not, open the Stamping6.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Louver icon.
2. Select Sketch.8, the profile previously defined on Wall.2.

The Louver Definition dialog box opens, providing default values.

3. Change the value in the different fields, if need be:
   - Height H,
   - Radius R1,
   - Radius R2,
   - Angle A1,
   - Angle A2.

4. Click OK to validate.
The specification tree indicates that the louver has been created.
This task shows you how to create a stiffness rib by specifying the punch geometrical parameters.

The Stamping.CATPart document is still open from the previous task. If not, open the Stamping7.CATPart document from the \online\samples\sheetmetal directory.

1. Click the Stiffness Rib icon.
2. Select Bend.1, where you want to place a stiffener. Note that the stiffener will always be centered on the bend radius, wherever the point may be along the curve.

The Stiffening Rib Definition dialog box opens, providing default values.

3. Change the value in the different fields, if need be:
   - Radius R1
   - Radius R2
   - Angle A
   - Length L

4. Click OK to validate.
The specification tree indicates the stiffness rib has been created.
Patterning

In this task, you are going to create cutouts according to a pattern. CATIA allows you to define two types of patterns: rectangular and circular patterns. These features make the creation process easier.

Open the Scenario3.CATPart document from the Samples/sheet metal directory. The Sheet Metal part looks like this:

1. Select the cutout you want to duplicate, that is the rectangular one.

2. Click the Rectangular Pattern icon.

The Rectangular Pattern Definition dialog box is displayed. Each tab is dedicated to a direction to define the location of the duplicated feature.

Set the specification for the First Direction:

3. Select the Edge.1, as shown, to specify the first direction of creation. An arrow is displayed on the wall.

4. Click the Reverse button or select the arrow to modify the direction.
5. Keep the Instances & Spacing options to define the parameters.

Choosing these parameters types dims the Length field because the application no longer needs this specification to space the instances.

6. Enter 2 as the number of instances you wish to obtain in the first direction.

7. Define the spacing along the grid: enter 30mm.

Defining the spacing along the grid and the length of your choice, would make the application compute the number of possible instances and space them at equal distances.

8. Now, click the Second Direction tab to define the other parameters.

Note that defining a second direction is not compulsory. Creating a rectangular pattern defining only one direction is possible.

9. Select the Edge.2, as shown, to define the second direction.

10. Keep the Instances & Spacing option: enter 8 and 10 mm in the appropriate fields.

Additional cutouts have been aligned along this second direction.
12. Click OK to repeat the cutouts. After the update, the Sheet Metal part looks like this:

![Diagram of Sheet Metal part]

13. Select this icon to unfold the part:
   The pattern is updated on the unfolded view.

![Unfolded Sheet Metal part]

Using a similar scenario, you can define a circular pattern.

To know more about patterns, refer to CATIA - Part Design [User's Guide](#).
Interoperability

In a CATPart document, you may have Part Design features and Sheet Metal features according to the following rules:

- Part Design features can be created before Sheet Metal features.
- A Part Design feature can also be created after Sheet Metal features as long as the part is in folded view.
- In the unfolded view, the Part Design feature will not be displayed.
- It is no longer possible to create Sheet Metal features after this last Part Design feature in folded view.

1. Create two walls with an Automatic Bend.
2. Switch to Part Design workbench.
3. Launch the Sketcher and draw an oblique line in the yz plane.
4. Click the icon to create a Stiffener.
5. Switch to the Sheet Metal workbench.
6. Click the Unfold icon.
The stiffener is not displayed on the unfolded view.

To add a new Sheet Metal feature, select the Bend for example and right-click the Define In Work Object item.
The new Sheet Metal feature will be added after the Bend but before the Stiffener.
Workbench Description

The CATIA - Sheet Metal Design Version 5 application window looks like this: Click the hotspots to display the related documentation.

Menu Bar

Toolbars
Menu Bar

The Menu Bar and items which are available in CATIA - Sheet Metal Design workbench are the standard ones. The tools and commands are described in the *V5 CATIA - Infrastructure User's Guide*. Refer to the [CATIA Menu Bar](#) section.
Toolbars

This section describes the various icons available in the Sheet Metal Design workbench. The toolbars are located in the application window border. The last icon is available whenever you are in the Drafting workbench.

See Managing Default Parameters
See Sketching...
See Creating the First Wall
See Creating Side Walls
See Designing in Context
See Creating Swept Walls
See Generating Bends from Walls
See Recognizing Thin Part Shapes
See Creating Automatic Bends
See Unfolding the Part
See Creating a Cutout
See Stamping
See Patterning
See Setting Constraints
Sheet Metal in Drafting

See Setting Constraints

See Extracting Drawings...
Customizing

This section describes how to customize settings. The task described here deals with permanent setting customizing.

Using Sheet Metal Standards Files

This task explains how to access company standards files.

Open a new document.

1. Click the Sheet Metal Parameters icon. The Sheet Metal Parameters dialog box opens.
2. Select the Sheet Standards Files... button. The Sheet Metal Part Samples window is displayed.
3. Indicate the path to the Sheet Metal tables.

These files are available under .xls or .txt format.
4. Click Open.

In the Sheet Metal Parameters dialog box, the Design Table icon appears opposite the Thickness and Bend radius fields.

The parameters are now in gray, indicating that you can no longer modify the values.

5. Click the Thickness Design Table icon and select line 1.

6. Click OK.

The parameter values are updated in the Sheet Metal Parameters dialog box.
7. Click the Bend Radius Design Table icon.

8. Select line 2 and click OK.

The parameter values are updated in the Sheet Metal Parameters dialog box.

9. Create a bend.

The Bend Definition dialog box displays a design table for the Bend Radius.

The default mode, it's to say the formula: Bend Radius = Part Radius is deactivated.

Let's see the Bend Radius Table, using this icon.

It shows the Bend Radius and the corresponding Bend Table.
10. Click OK.

If the Angle value is contained in the Bend Table, the Bend Allowance uses the corresponding value.
If not, the Bend Allowance is computed according to the KFactor.
An alternative if you use the V5R2 Sheet Metal Tables: for example BNDTABL2. the steps 1 to 4 are identical.

5. Click the Design Table icon and select a line.

6. Click OK.
The parameter values are updated in the Sheet Metal Parameters dialog box.
At that time, the parameters Thickness and Bend radius are driven by the design table.
They are now in gray, indicating that you can no longer modify the values.
Note that if you create a bend, there is no design table: it's the formula which is used.

To disable the access to design tables:

- Select the Tools -> Options -> Part -> Display items and check Relations:
  - the Design Table icon is displayed in the specification tree.
  - Right-click this icon: the contextual menu appears.
Select BNDTABL2.txt object -> Deactivate

The relation is no longer used but still exists. It can be activated at any time.
## Glossary

<table>
<thead>
<tr>
<th>Letter</th>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>bend</td>
<td>a feature joining two walls</td>
</tr>
<tr>
<td></td>
<td>bend extremity</td>
<td>axial relimitation for a straight bend</td>
</tr>
<tr>
<td>C</td>
<td>cutout</td>
<td>a feature corresponding to an opening through a feature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the shape of the opening corresponds to the extrusion of a profile.</td>
</tr>
<tr>
<td>E</td>
<td>extrusion</td>
<td>a feature created by extruding a profile and adding thickness</td>
</tr>
<tr>
<td>F</td>
<td>flange</td>
<td>a feature created by sweeping a profile along a spine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the different flanges available are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>simple and swept flange, hem and tear drop</td>
</tr>
<tr>
<td>P</td>
<td>pattern</td>
<td>a set of similar features repeated in the same feature or part</td>
</tr>
<tr>
<td></td>
<td>profile</td>
<td>an opened or closed shape including arcs and lines created by the profile command in the Sketcher workbench</td>
</tr>
<tr>
<td>R</td>
<td>reference wall</td>
<td>the first created wall; when unfolding the part, it is the fixed wall.</td>
</tr>
<tr>
<td>S</td>
<td>stamp</td>
<td>a feature created by embossing sheet metal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the different stamps available are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>point, extruded hole, curve, surface, bridge, louver and stiffening rib.</td>
</tr>
<tr>
<td>W</td>
<td>wall</td>
<td>a feature created by adding thickness to a profile</td>
</tr>
</tbody>
</table>